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 eact เปนไลบรารีหรือเฟรมเวิรกของภาษา JavaScript ที่ไดรับความนิยมสูงสุดในปจจุบัน โดยเนื้อหา 

 ในบทนี ้เราจะกลาวถงึการตดิตัง้เครื+องมอืทีจ่ําเปนทัง้หมดสําหรบัการใช React จากนัน้ กจ็ะเริม่ตนเรยีนรู 

วิธีการเขียนโคด HTML และ CSS ตามแนวทางของ React หรือที่เรียกวา JSX รวมถึงลักษณะปลีกยอยอื+น ๆ   

ที่เราควรรูจักในเบื้องตน เพื+อเปนพื้นฐานสําหรับการพัฒนา Web Application ที่จะกลาวถึงในบทตอ ๆ  ไป

การใช VS Code
เครื+องมือในการเขียนและทดสอบโคดของ React ที่ไดรับความนิยมสูงสุดในปจจุบันก็คือ Visual Studio  

Code (VS Code) ซึ่งเปนโปรแกรมประเภท IDE (Integrated Development Environment) ท่ีมีลักษณะ 

โดดเดนหลายประการ เชน ใหใชงานฟรี รองรับการเขียนโคดไดหลายภาษา และที่สําคัญคือ มีสวนเสริม 

การทํางานใหเลือกใชมากมาย สําหรับการติดตั้ง VS Code เราสามารถดาวนโหลดชุดติดตั้งไดจากเว็บไซต 

https://code.visualstudio.com/download

การติดตั้งและพื้นฐาน 
ของ React
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หลังดาวนโหลดเสร็จ ก็ดับเบิลคลิกไฟลติดต้ัง ซึ่งขั้นตอนตาง ๆ  ก็ทําเหมือนกับโปรแกรมทั่วไป และ

เนื+องจาก VS Code เปน IDE สําหรับการเขียนโคดทั่วไปที่ไมเจาะจงวาเราตองใชภาษาใด ดังนั้น เครื+องมือและ

ตัวชวยตาง ๆ  ก็เปนสิ่งที่สามารถนําไปใชไดกับภาษาคอมพิวเตอรเกือบทั้งหมด โดยลักษณะที่น�าสนใจซึ่งเราอาจ

ไดใชงานในบางครั้ง มีดังนี้

หนาจอ Welcome
ปกติแลว เมื+อเราเปดเขาสู VS Code จะปรากฏหนาจอ Welcome โดยอัตโนมัติ ดังภาพ

สิง่ทีน่�าสนใจของหนาจอ Welcome เชน ทางลดัในการเปดโฟลเดอรเปาหมายไดรวดเรว็ขึน้ หรอืการแจง

ขอมูลขาวสาร รวมถึงการอัปเดตตาง ๆ  แตหากหนาจอ Welcome ไมปรากฏ เชน เราอาจคลิกปดไปแลว หรือ

ตั้งคาไมใหแสดงอีก แตตองการแสดงอีกครั้ง ก็เลือกที่เมนู Help > Welcome

การติดตั้งสวนขยายของ VS Code
การเขยีนโคดในบางกรณ ีเราอาจตองใชสวนขยาย (Extension) สําหรับการทาํงานรวมกบัภาษานัน้ ๆ  ซึง่

เราสามารถตรวจสอบและดาวนโหลดสวนขยายมาใชงานไดดังนี้

1. ในขณะนัน้ ตองเชื+อมตอกบัอนิเทอรเนต็ แลวคลกิทีไ่อคอน Extensions ทีข่อบดานซาย (ดภูาพถดัไป)  

หรือเลือกที่เมนู View > Extensions

2. ใสคียเวิรดลงไป หลังจากนั้นจะปรากฏรายชื+อสวนขยายที่อาจเกี่ยวของกับคียเวิรด
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3. ถาเราตองการติดตั้งสวนขยายใด ก็คลิกปุม Install บนรายการนั้น หรือหากตองการดูรายละเอียด

เพิ่มเติมเกี่ยวกับสวนขยายใด ก็คลิกที่รายการดังกลาว ดังภาพ

1

2

3

4. สวนขยายใดทีถ่กูตดิตัง้เอาไวแลว จะมีรปูไอคอน 

Manage ที่มุมลางขวาของรายการนั้น ทั้งนี้หาก

เราตองการลบสวนขยายนั้นทิ้งไป ก็ทําดังนี้

(1) คลิกที่รูปไอคอนดังกลาว

(2) เลือกที่ Uninstall

การเปลี่ยนรูปแบบสีของ VS Code
รูปแบบสีหรือ Color Theme ที่ VS Code เลือกไวลวงหนาจะเปนสีดํา (Dark) แตหากเราไมถูกใจสิ่งนี้ 

VS Code ก็มีรูปแบบสีมาใหเลือกบางสวน ซึ่งขั้นตอนคือ

1. คลิกที่ไอคอน Manage ตรงมุมลางซาย

2. เลือกเมนู Color Theme แลวเลือกรูปแบบสีที่ตองการ (กรณีของผูเขียนจะเลือก Tomorrow Night 

Blue)

1

2
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1

2

    

การยอและขยายขนาด (Zoom In/Out)
ขนาดปกติของฟอนตและไอคอนที่ VS Code กําหนดไวลวงหนา จะเปนดังภาพถัดไป (ซาย)

    

หากเราตองการใหฟอนตและไอคอนมีขนาดใหญอกี 1 ระดับ ก็เลอืกทีเ่มน ูView > Appearance > Zoom In  

หรอืกด <Ctrl => และถาทาํเชนน้ีอกี ขนาดจะเพ่ิมขึน้อกี 1 ระดบั ดงัภาพทีแ่ลวดานขวามือ แตหากเราตองการให

ขนาดของฟอนตและไอคอนเลก็ลง 1 ระดบั กเ็ลอืกทีเ่มน ูView > Appearance > Zoom Out หรอืกด <Ctrl ->  

และถาทําเชนนี้อีก ขนาดจะลดลงอีก 1 ระดับ

การกําหนดรูปแบบฟอนตของ Code Editor
หากเราตองการปรับเปลี่ยนฟอนตของ Code Editor ก็ทําตามขั้นตอนดังนี้

1. คลิกที่ไอคอน Manage ตรงมุมลางซาย

2. เลือกที่เมนู Settings

3. เลือกแท็บ User

4. คลิกที่ Text Editor

5. คลิกเมนู Font
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จากนั้นก็กําหนดรูปแบบฟอนตตามที่เราตองการ เชน Font Family (ชนิดฟอนต), Font Size และ  

Font Weight เปนตน

1

2

    

3

5

4

การใช Terminal ของ VS Code
การทดสอบ React บน VS Code มีบางกรณีที่เราตองพิมพคําสั่งผาน Command Line หรือ Terminal  

เพื+อดําเนนิการตาง ๆ  เชน การสรางแอปของ React การเขาและออกจากไดเรก็ทอร ีการตดิตัง้โมดลู การรนัทดสอบ 

แอป เปนตน และยังมีกรณีอื+น ๆ  อีกมากมายที่เราอาจตองพิมพคําสั่งผาน Terminal ดังนั้น จึงควรมีพื้นฐาน 

การเขียนคําสั่งผาน Terminal เอาไวบาง ดังแนวทางตอไปนี้

ปกติแลว Terminal จะยังไมปรากฏ ยกเวนเราจะเคยเปด

เอาไวเมื+อใชงาน VS Code คราวที่แลว ทั้งนี้ หากเราตองการเปด

เขาสู Terminal ใหเลือกที่เมนู Terminal > New Terminal

หลังจากนั้น เมื+อ Terminal ปรากฏขึ้น ซึ่งตามปกติจะแบง

เปนหลายแทบ็ หากเราตองการเขยีนคาํสัง่กใ็หเลอืกแท็บ Terminal
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VS Code นั้นมี Terminal ใหเลือกหลายแบบ เชน Command Prompt (cmd) หรือ PowerShell 

เปนตน ซึ่งเราจะใชงานแบบไหนก็ได โดยสามารถเลือกรูปแบบที่

ตองการไดดังนี้

1. เปด Terminal ขึ้นมาแสดงกอน 

2. คลิกที่ไอคอนลูกศรดังภาพถัดไป แลวเลือกรูปแบบ 

Terminal ตามตองการ

3. หลังจากนั้น Terminal แบบใหมที่เราเลือกจะถูกเพิ่มเขามา สวน  

Terminal อันเดิม ถายังปรากฏอยูก็สามารถลบทิ้งไปโดยการคลิกที่

ไอคอนถังขยะ

หลังจากที่เราใชงาน Terminal เสร็จแลว หากไมตองการใชงานอีก อาจ

ลบวินโดว Terminal ทิ้งไป (สรางใหมได) โดยคลิกที่ไอคอนรูปถังขยะบนแถบ

ทูลบารของมัน และหากตองการใชงานอีกก็ตองสรางข้ึนมาใหม โดยเลือกที่เมนู 

Terminal > New Terminal เชนเคย หรือถาตองการซอน Terminal ชั่วคราว 

เชน กรณีที่ยังไมจําเปนตองใชงานขณะนั้น แตอาจจะกลับมาใชงานในภายหลัง (ตองไมปด VS Code) ก็ใหคลิก

ไอคอน X ที่มุมขวาบนของแถบทูลบารของมัน และหากจะกลับมาใชงานอีก ใหเลือกที่เมนู View > Terminal

การใช Terminal เราตองพิมพคําส่ังสําหรับดําเนินการในกรณีนั้น ๆ  ลงไป อยางไรก็ตาม คําส่ังของ 

Terminal นั้นมีเปนจํานวนมาก แตมีเพียงไมกี่อันที่เราจะไดใชงานอยูบอย ๆ  ดังนั้น จึงขอนํามากลาวเฉพาะ 

คําสั่งที่น�าสนใจ ซึ่งวิธีการใชงานคือ ใหเปดเขาสู Terminal แลวพิมพคําสั่งที่ตองการลงไป โดยแนวทางการใช

คําสั่งที่สําคัญมีดังนี้

 คําส่ัง cd (หรือ chdir) สําหรับเปลี่ยน (change) ไปยังไดเร็กทอรีที่ระบุ โดยกําหนดไดเร็กทอรี 

เปาหมายตามหลังคําสั่งนี้ เชน

C:\Users\MY>cd d:\ebooks\javascript ไปยังไดเร็กทอรี d:\ebooks\javascript

C:\Users\MY>cd documents\node ไปยังไดเร็กทอรีที่อยูถัดจากตําแหน�งที่แสดง prompt คําส่ัง 

ในขณะนั้น ซึ่งกรณีนี้คือ C:\Users\MY ดังนั้น คําสั่งดังกลาวจะ

ไปที่ C:\Users\MY\Documents\node

C:\Users\MY>cd ..    (2 จุด) ไปยังไดเร็กทอรีกอนนี้ 1 ระดับ นั่นคือ C:\Users

C:\Users\MY>cd \ ไปยังไดเร็กทอรีเริ่มตนที่แสดง prompt คําส่ังในขณะนั้น ซึ่ง

กรณีนี้จะไปที่ C:\
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 คําสั่ง md (หรือ mkdir) สําหรับสราง (make) ไดเร็กทอรีใหม โดยระบุชื+อไดเร็กทอรีที่จะสรางใหม 

ตามหลังคําสั่งนี้ เชน

C:\Users\MY>mkdir js สรางไดเร็กทอรี (โฟลเดอร) ที่ชื+อ js ซอนไวในตําแหน�งที่แสดง 

prompt คําสั่งในขณะนั้น ซึ่งกรณีนี้จะสรางไวที่ C:\Users\MY\js

C:\Users\MY>mkdir js\node ถายังไมมีไดเร็กทอรี js ก็จะสรางขึ้นใหม แลวสรางไดเร็กทอรี 

node ซอนไวใน js

C:\Users\MY>md d:\javascript\code สรางไดเร็กทอรี javascript\code ไวที่ d:\

 คําสั่ง rm (หรือ rmdir) สําหรับลบ (remove) ไดเร็กทอรี (ลบไดเฉพาะไดเร็กทอรีวาง) โดยระบุชื+อ

ไดเร็กทอรีที่ตองการลบตามหลังคําสั่งนี้ แตหากไดเร็กทอรีนั้นไมวาง เชน มีไดเร็กทอรียอย ๆ  และ/

หรือ ไฟลอยูขางใน จะลบไมได

C:\Users\MY>rmdir test ลบไดเร็กทอรี (โฟลเดอร) ที่ชื+อ test ซึ่งซอนอยูในตําแหน�งที่แสดง 

prompt คําสั่งในขณะนั้น สําหรับกรณีนี้คือ C:\Users\MY\test

C:\Users\MY>rmdir d:\bad_dir ลบไดเร็กทอรี (โฟลเดอร) ในตําแหน�งที่ระบุ (ถาวาง)

 คําสั่ง del (หรือ erase) สําหรับการลบไฟล โดยระบุตําแหน�งไฟลดังกลาวตามหลังคําสั่งนี้ แตหาก

กําหนดเปนชื+อไดเร็กทอรี จะหมายถึงการลบไฟลทั้งหมดในไดเร็กทอรีนั้น

C:\Users\MY>del temp.docx ลบไฟล temp.docx ออกจาก c:\Users\MY

C:\Users\MY>del d:\test\badfile.txt ลบไฟล badfile.txt ออกจาก d:\test

C:\Users\MY>erase test1\test2 ลบไฟลทั้งหมดออกจากไดเร็กทอรี c:\Users\MY\test1\test2  

(แตไมลบไดเร็กทอรี) และจะมี prompt ใหเรายืนยันดวย

 คําสั่ง ren หรือ rename สําหรับเปลี่ยนชื+อไฟลหรือไดเร็กทอรี โดยระบุชื+อไฟลหรือไดเร็กทอรีเดิม

แลวตามดวยชื+อใหม เชน

C:\Users\MY>ren test.js demo.js เปลี่ยนชื+อไฟล test.js ซึ่งอยูในตําแหน�งที่แสดง prompt คําสั่งใน

ขณะนัน้ สําหรบักรณีนีค้อื C:\Users\MY\test.js ไปเปนชื+อ demo.js

C:\Users\MY>rename temp backup เปลีย่นชื+อไดเรก็ทอร ีซึง่ซอนอยูในตาํแหน�งทีแ่สดง prompt คาํสัง่ 

ในขณะนัน้ สําหรบักรณนีีค้อื C:\Users\MY\temp ไปเปนชื+อ backup
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 คําสั่ง cls สําหรับเคลียรหนาจอ (screen) โดยไมจําเปนตองระบุพารามิเตอรใด ๆ  เชน

C:\Users\MY>cls เคลียรขอความทั้งหมดบนหนาจอของ Terminal

 คําสั่ง dir สําหรับแสดงรายชื+อไฟลและไดเร็กทอรียอย ๆ  ที่อยูในไดเร็กทอรีของ prompt คําสั่งใน

ขณะนั้น หรือที่ระบุตามหลังคําสั่งนี้ เชน

C:\Users\MY>dir c:\ แสดงรายชื+อไฟลและไดเร็กทอรีใน C:\Users\MY>

C:\Users\MY>dir c:\ แสดงรายชื+อไฟลและไดเร็กทอรีใน c:\

C:\Users\MY>dir documents\js แสดงรายชื+อไฟลและไดเร็กทอรีใน c:\Users\MY\documents\js

C:\Users\MY>dir d:\temp\download แสดงรายชื+อไฟลและไดเร็กทอรีใน d:\temp\download

การติดตั้ง Node.js และคําสั่ง NPM
ถึงแม React จะเปนการสราง Web Application สําหรับฝง Frontend เปนหลัก แตโครงสรางของ

แอปจะอยูในรูปแบบของ Node.js Application และจําเปนตองอาศัย Engine ของ Node.js ในการทํางาน  

ดังนั้น องคประกอบสําคัญอีกอยางหนึ่งที่เราตองจัดเตรียมไวลวงหนาก็คือ Node.js ซึ่งมีขั้นตอนการติดตั้งดังนี้

1. สามารถดาวนโหลดชุดเครื+องมือของ Node.js ไดฟรีที่เว็บไซต https://nodejs.org/

2. หลังจากดาวนโหลด ก็ดับเบิลคลิกไฟลติดตั้ง ซึ่งขั้นตอนตาง ๆ  ก็เหมือนโปรแกรมทั่วไป 
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หลังการติดตั้ง เมื+อเปดเขาสู VS Code ก็สามารถใชงาน Node.js ผาน Terminal  ทันที ซึ่งโดยทั่วไปจะ

เปนการพิมพชุดคําสั่งที่เรียกวา NPM (Node Package Manager) สําหรับคําสั่งที่เราควรรูจักในเบื้องตนมีดังนี้

 npm install <ชื�อแพก็เกจ> สาํหรบัการตดิตัง้แพก็เกจตามชื+อทีร่ะบ ุเชน npm install react-wizard

 npm install -g <ชื�อแพก็เกจ> เมื+อเราตองการตดิตัง้แพก็เกจแบบ global ใหสามารถใชงานระหวาง

แอปได โดยไมจาํเปนตองตดิตัง้แบบซ้ํา ๆ  ในแตละแอปทีจ่ะใชงาน เชน npm install -g hello-world

 npm install <-g> <แพ็กเกจ1> <แพ็กเกจ2> <แพ็กเกจ3> ... เมื+อตองการติดตั้งหลาย ๆ   

แพก็เกจพรอมกนั (ไมตองเสยีเวลาตดิตัง้ทลีะแพก็เกจ) เชน npm install reactive reaction reactor

 npm uninstall <ชื�อแพก็เกจ> เมื+อตองการลบหรอืยกเลกิการตดิตัง้แพก็เกจตามชื+อระบอุอกไปจาก

แอป เชน npm uninstall chain-reaction

นอกจากนี้ ยังมีอีกหลายคําสั่งที่เราอาจไดใชงานในบางกรณี รวมถึงวิธีการนําคําสั่งที่กลาวมานี้ไปใชงาน

จริง เราจะไดเรียนรูเพิ่มเติมอีกครั้งในหัวขอตอ ๆ  ไป

การใชโมดูลของ JavaScript
โมดูล (Module) ก็คือไฟลที่จัดเก็บโคดของจาวาสคริปต ซ่ึงอาจประกอบดวย ตัวแปร ฟงกชัน คลาส 

ออบเจ็กต หรืออื+น ๆ  เพื+อนําไปใชงานยังสวนอื+น ๆ  และเนื+องจากการพัฒนาเว็บดวย React นั้น จะเกี่ยวของ 

กับการใชโมดูลไปตลอด ดังนั้น เราควรรูจักพื้นฐานในการนําเขา (import) และสงออก (export) โมดูลเอาไว 

ลวงหนา เพื+อใหงายตอการเรียนรูในหัวขอตอ ๆ  ไป
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การสรางและสงออกโมดูล
เนื+องจากโมดูลก็คือไฟลจาวาสคริปต (.js) ดังนั้น หากจะสรางโมดูล เราก็เริ่มจากการสรางไฟลพรอม

กําหนดชื+อใหกับมัน (ชื+อไฟลจะเปนชื+อโมดูล) และใหมีสวนขยายเปน .js เชน ในการทดสอบนี้ ผูเขียนสรางไฟล

ชื+อ math.js แสดงวาโมดูลนี้ก็จะชื+อ math เปนตน และสมาชิกที่อยูในโมดูลอาจเปน ตัวแปร ฟงกชัน คลาส 

ออบเจ็กต ก็ได สุดทายก็สงออกไปดวยคําสั่ง export เชน

const PI = 3.141

function add(num1, num2) {
 return num1 + num2
}

class Random {
 static getInteger(min, max) {
  return min + Math.floor(Math.random() * (max - min))   
 }
 static getBoolean() {
  return (this.getInteger(1, 10) <= 5) ? true : false
 }  
}

export {PI, add, Random} //ระบุสิ่งที่จะสงออกไวในวงเล็บ { }

//หรือเราอาจสงออกในชื+อใหม โดยใชคียเวิรด as เชน

//export {PI, Random, add as plus} 
//หมายถึง PI, Random ใชชื+อเดิมแต add เปลี่ยนเปน plus

หรืออีกวิธีคือ นําคียเวิรด export มาวางไวดานหนาสมาชิกของโมดูลที่จะสงออกไป ซึ่งเรียกวา inline 

export เชน

export const PI = 3.141

export function add(num1, num2) { 
 ... 
}

export class Random {
 ...
}
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การนําเขาโมดูล
การนําเขาโมดูล จะใชคําสั่ง import-form ดังรูปแบบตอไปนี้

import {identifier} from <location>

 identifier ใหระบชุื+อของสมาชกิทีต่องการนาํเขา เชน ชื+อตวัแปร ฟงกชนั คลาส หรอืออบเจก็ต เปนตน 

โดยตองเขียนไวในวงเล็บ { } เชน {add, number, Random}

 location คือตาํแหน�งของโมดลู โดยเทยีบกบัตาํแหน�งไฟลทีน่าํโมดลูนัน้มาใชงาน ซึง่การระบตุาํแหน�ง

มีหลักการดังนี้

 ๏ หากไฟลของโมดูล และไฟลที่ตองการใชโมดูล อยูในไดเร็กทอรีเดียวกัน ใหแทนตําแหน�งดวย  

'./ชื+อไฟล' เชน './math' โดย . หมายถึงไดเร็กทอรีปจจุบัน

 ๏ แตถาไฟลของโมดูล อยูในไดเร็กทอรียอย ๆ  ลงไปอีก เราก็ตองระบุตําแหน�งไปตามลําดับจนถึง

ไฟลของโมดูล เชน import { ... } from './modules/js/math'

เชน จากโมดูล math ที่เราไดสรางไวในหัวขอที่แลว หากเราตองการนําเขาฟงกชัน add, คลาส 

Random จากโมดูล math มาใชงานในไฟล test-module.js ซึ่งเก็บอยูในโฟลเดอรเดียวกับไฟล

โมดูล ก็อาจกําหนดโคดดังนี้ 

import {add, Random} from './math'

alert(add(10, 20)) 
let r = Random.getInteger(1, 100)

 เราอาจตั้งชื+อใหมใหกับสมาชิกบางอันของโมดูลดวย as แลวเรียกใชงานจากชื+อที่ตั้งขึ้นใหม เชน

import {add as plus, Random} from './math'

let x = plus(1, 99)

 หากเราตองการนําเขาทุกอยางที่มีในโมดูล สามารถแทนดวยเครื+องหมาย * แลวตั้งชื+อใหกับมันดวย 

as ซึ่งกรณีนี้ไมตองเขียนในวงเล็บ { } จากนั้นเราอางถึงสมาชิกในโมดูลผานชื+อที่ตั้งขึ้น

import * as math from './math'

let x = math.add(10, 90)
let r = math.Random.getInteger(1, 100)
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การสงออกแบบ default
ภายในโมดูล หากมีสมาชิกเพียงอันเดียว เชน คลาสเดียว หรือออบเจ็กตเดียว หรือฟงกชันเดียว เรา

สามารถสงออกสมาชิกแบบดีฟอลต โดยมีหลักการดังนี้

 หากใชวิธี inline ก็ระบุคําวา export default ที่สมาชิกตัวนั้น เชน

export default class Test { 
 static hello() { }
}

 หรืออาจกําหนดสมาชิกขึ้นมากอน แลวใชคําสั่ง export ทีหลัง เชน

class Test() {
 static hello() { }
}

export default Test      //แบบที ่1
//export {Test as default}  //แบบที ่2

 ขั้นตอนการนําเขา ไมตองมีวงเล็บ { } ครอบชื+อสมาชิกที่สงออกแบบ default สวนหลักการอื+น ๆ  ก็

เหมือนเดิม เชน

import Test from './test'

Test.hello()

 ถาตองการนําเขาโมดูลที่สงออกแบบ default แลวเปลี่ยนชื+อ ก็ใช as ตามเดิม แตกรณีนี้ตองเขียน

ในวงเล็บ { } เชน

import {default as demo} from './test'

demo.hello()

อยางไรก็ตาม ไมจําเปนตองใช default กับโมดูลที่มีสมาชิกเพียงอันเดียว เราสามารถใชกับโมดูลที่มี

สมาชิกมากกวา 1 อันได แตในโมดูลเดียวกันจะมีสมาชิกแบบ default ไดเพียงอันเดียวเทานั้น เชน
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//แบบที ่1
export function hi() { return 'Hi' }
export default function hello() { return 'Hello' } //สงออกแบบ default
export function hey() { return 'Hey' }

//แบบที ่2
function hi() { ... }
function hello() { ... }
function hey() { ... }

export {hi, hey, hello as default}   //สงออก hello แบบ default

แลวในขั้นตอนการนําเขา ก็กําหนดโคดแบบใดแบบหนึ่งในลักษณะดังนี้

//เอาตัว default ขึ้นกอน

import hello, {hi, hey} from './example'

//หรือแบบอื+น ๆ  เชน

//import {default as hello, hi, hey} from './example'
//import hello, * as H from './example'

ทั้งหมดที่กลาวคือ หลักการพื้นฐานทั่ว ๆ  ไปตามขอกําหนดของ JavaScript (ECMAScript) ซึ่งเมื+อนํา 

ไปใชงานใน React Application อาจมีบางลักษณะที่แตกตางไปจากนี้เล็กนอย โดยสวนใหญก็ยังเปนไปตาม

หลักการที่กลาวมานี้

การสรางและทดสอบ React Application
การสรางเว็บดวย React ตองทําในแบบของ Web Application ที่ประกอบดวยไฟลหลายชนิดรวมกัน 

เชน HTML, CSS, JavaScript รวมถึงโมดูลของ React ซึ่งอยูในรูปแบบของ Node.js อยางไรก็ตาม React ได

จดัเตรียมคาํสัง่ npm ใหเราใชในการสรางแอปเอาไวแลว ซึง่เราแคพมิพคาํส่ังลงใน Terminal แลวองคประกอบ 

(ไฟล) พื้นฐานทั้งหมดของ React App ก็จะถูกสรางขึ้นหรือดาวนโหลดมาติดตั้งใหโดยอัตโนมัติ ท้ังนี้หากผูอาน

เคยสรางแอปของ Node.js มากอน ในกรณีของ React ก็ใชหลักการเดียวกัน โดยมีขั้นตอนปลีกยอยดังตอไปนี้

สรางโฟลเดอรสําหรับจัดเก็บแอปตาง ๆ
หากเราตองการสรางหลาย ๆ  แอปเพื+อทดสอบการทํางานในกรณีตาง ๆ  ก็ควรสรางโฟลเดอรเพื+อเก็บ

แอปเหลานั้นใหเปนสัดสวนเฉพาะ สําหรับชื+อและตําแหน�งการจัดเก็บ ผูอานสามารถกําหนดไดเองตามตองการ 

แตควรจะเขาถึงไดงาย เชน กรณีที่จะนําเสนอประกอบการใชงานในหนังสือเลมนี้ ผูเขียนจะสรางโฟลเดอรชื+อ 
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react ไวที่ตําแหน�ง c:\react สําหรับเก็บแอปของ React ดังภาพถัดไป ซึ่งผูอานอาจสรางโฟลเดอรผาน File 

Explorer หรือใชคําสั่ง mkdir บน Terminal ก็ได เชน mkdir c:\react 

การติดตั้งคําสั่ง create-react-app
เนื+องจากการสราง React App เราตองพิมพคาํสัง่ในแบบของ npm แตคาํส่ังนีไ้มใชองคประกอบพืน้ฐาน 

ของ Node.js ดังนั้น เราจะตองติดตั้งเพิ่มลงไปกอน โดยใชรูปแบบดังนี้ 

npm install -g create-react-app

กรณีนี้ เราควรระบุออปชั่น -g ลงไปดวย เพื+อใหคําสั่งหรือแพ็กเกจนี้ถูกติดตั้งแบบ Global แลวในการ

สรางแอปครั้งตอ ๆ  ไป ก็ไมจําเปนตองติดตั้งคําสั่งนี้ซํ้าอีก แตสามารถใชงานไดตลอด

การสราง React App
การสราง React App จะตองใชคําสั่ง create-react-app ตามที่เราไดติดตั้งเอาไวในหัวขอที่แลว ดวย

รูปแบบดังนี้

create-react-app <ชื+อแอป>

โดยเราตองพิมพคําสั่งนี้ลงบน Terminal แตเนื+องจากแอปจะถูกสรางในโฟลเดอรหรือตําแหน�งที่แสดง 

Prompt อยูในขณะน้ัน ซึง่หากไมใชเปาหมายทีเ่ราตองการ กใ็หใชคาํสัง่ cd เพื+อเปลีย่นตาํแหน�งไดเร็กทอรีกอน 

แลวคอยสรางแอป โดยตามขอกําหนดในหนังสือเลมนี้คือ จะสราง

แอปไว C:\react ดังนั้น แนวทางโดยรวมก็จะเปนดังภาพ ซึ่งสมมติ

วาตองการสรางแอปชื+อ app1-1
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การสราง React App ดังที่กลาวมา เราตองเชื+อมอินเทอรเน็ตและใชเวลาพอสมควร กวาไฟลทั้งหมดจะ

ถูกดาวนโหลดมาติดตั้งจนครบสมบูรณ โดยในขณะที่เขียนหนังสือเลมนี้ React App จะมีขนาดเริ่มตนประมาณ 

157 MB ตอ 1 แอป และหลังจากการสรางแอปเสร็จสิ้น หากเราเปด File Explorer เขาไปดูที่ตําแหน�ง 

การจัดเก็บแอป ก็จะปรากฏโฟลเดอรและไฟลดังนี้

การเปดเขาสูแอป
หลังจากที่เราสรางแอปดังหัวขอที่ผานมา หากตองการเปดเขาสูแอป ก็สามารถทําไดหลายวิธี ดังตอไปนี้ 

โดยสมมติวา เราตองการเปดแอปที่ชื+อ app1-1

 วิธีที่ 1 เปดจากเมนูของ VS Code โดยเลือกที่ File > Open Folder  จากนั้นก็เลือกโฟลเดอร

ของแอปที่เราสรางเอาไว
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 วิธีที่ 2 โดยการพิมพคําสั่งผาน Terminal ของ VS Code ดังขั้นตอนตอไปนี้

1) ในขณะน้ัน Prompt ตองชีอ้ยูทีโ่ฟลเดอรของแอป ถาอยูทีต่าํแหน�งอื+น ใหใชคาํส่ัง cd เพื+อเขาไป

ยังโฟลเดอรของแอป เชน cd c:\react\app1-1

2) พิมพคําสั่งเพื+อเปดโฟลเดอรดังนี้ 

code . -r 

โดยที่ . (จุด) หมายถึงเปดโฟลเดอรปจจุบันที่แสดง Prompt อยูในขณะนั้นและ -r หมายถึง 

เปดแทนที่แอปเดิมที่กําลังเปดอยู (ถามี) หรือเปดในวินโดวปจจุบันของ VS Code นั่นเอง

นอกจากน้ี ยังมอีกีวธิคีอื การระบตุาํแหน�งโฟลเดอรทีต่องการเปดลงไปโดยตรง เชน code c:\react\

app1-1 -r เปนตน

 วิธีที่ 3 ถาเราเคยเปดแอปนัน้มากอน เมื+อเขาสู VS Code จะปรากฏรายชื+อบนหนาจอ Welcome 

ในกลุม Recent ซึ่งหากมีรายชื+อแอปที่เราตองการ ก็สามารถเปดผานตรงนี้ไดเลย (หากหนาจอ 

Welcome ไมปรากฏ ใหเลือกที่เมนู Help > Welcome)

หลังจากเปดแอปขึ้นมาแลว หากตองการปด ใหเลือกที่เมนู File > Close Folder หรือ File > Exit (วิธีนี้  

เมื+อเปด VS Code ครั้งตอไป จะเขาสูแอปที่เคยเปดครั้งลาสุดโดยอัตโนมัติ)

ลักษณะโครงสรางของ React Application
หลงัจากทีเ่ราไดสราง React App ขึน้มาแลว เมื+อเปดเขาสูแอปดงัวธิกีาร 

ที่ไดมาแลว จะปรากฏโครงสรางหรือองคประกอบภายในแอปดังภาพ สําหรับ

โฟลเดอรและไฟลที่สําคัญภายในแอป ซึ่งเราควรรูจักในเบื้องตนมีดังนี้

 node_modules เปนโฟลเดอรสําหรับจัดเก็บโมดูลที่จําเปนสาํหรับ

การทํางานของ React โดยโมดูลเหลาน้ีจะอยูในรูปแบบของ Node.js  

ทั้งนี้ หากเราติดตั้งโมดูลอื+น ๆ  เพิ่มเติมในภายหลังดวยคําสั่ง npm  

ก็จะถูกนํามาเก็บไวในโฟลเดอรนี้

 public เปนโฟลเดอรสําหรับจัดเก็บไฟลที่ตองใชงานรวมกันระหวาง

เพจหรือไฟลอื+น ๆ  ซ่ึงโดยสวนใหญจะเปนไฟลแบบ Static หรือไฟลที่ไมมีการเปลี่ยนเนื้อหานั่นเอง 

เชน ไฟล HTML , รูปภาพ เปนตน

 src เปนโฟลเดอรสําหรับจัดเก็บไฟล Source Code หลักของแอป เชน ซึ่งโดยสวนใหญจะเปน 

JavaScript แตบางกรณีก็อาจเปน CSS โดยไฟลสําคัญภายในโฟลเดอรนี้คือ
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 ๏ src\App.css เปนทีจ่ดัเกบ็โคด CSS สวนกลางสําหรับนาํไปวางท่ีสวนอื+น ๆ  ในแบบ Placeholder 

CSS

 ๏ src\App.js เปนไฟลของคอมโพเนนตระดับ Top-Level ของ React

 ๏ src\index.js คือไฟลหลักสําหรับหนาแรกของแอปพลิเคชัน หรือเทียบไดกับ Homepage ของ

เว็บไซตนั่นเอง

 ๏ src\index.css เปนไฟล CSS สําหรับหนาแรก หรือใชคูกับไฟล index นั่นเอง

 package.json เปนไฟลที่เก็บการตั้งคาตาง ๆ  เกี่ยวกับแอปพลิเคชันนั้น 

 package-lock.json ใชจัดเก็บขอมูลของโมดูลที่ติดตั้งในโฟลเดอร node_modules เพื+อใชเปน 

คาอางอิงสําหรับคําสั่ง npm โดยทั่วไป เราไมจําเปนตองจัดการใด ๆ  กับไฟลนี้

 .gitignore รายชื+อไฟลที่ไมควรเพิ่มลงใน Git แตใหใชภายในแอปนี้เทานั้น

 README.md สวนขยาย .md คอืไฟลประเภท Markdown และสําหรบัไฟล README.md เปนการ

แสดงคําสั่งและขอมูลที่จําเปนเมื+อเรานําไปแอปไปใชบนแพลตฟอรมอื+น เชน GitHib

ทั้งหมดนี้เปนเพียงองคประกอบพื้นฐานบางสวนที่ React สรางมาให นอกจากนี้ เราอาจตองสรางไฟล

เพิ่มเติมหรือนํามาจากที่อื+น ๆ  เพื+อใหแอปสามารถทํางานไดตามตองการ

การรันทดสอบแอป
หากเราตองการรันทดสอบองคประกอบพื้นฐานที่ React สรางมาให ก็ตองเปดเขาสูแอปนั้นกอน ดังที่

กลาวไปในหัวขอที่แลว จากนั้นก็ทําตามขั้นตอนดังนี้

1. ที่ Terminal ตองเขาไปในโฟลเดอรของแอปที่

ตองการรนั (ยกเวน Prompt จะแสดงอยูทีต่าํแหน�ง

นั้นอยูแลว) เชน สมมติวาเราตองการรันแอป 

app1-1 ก็ใชคําสั่ง cd เพื+อเขาไปยังโฟลเดอรดัง

กลาว

2. พิมพคําสั่ง npm start ลงบน Terminal

3. ตอจากนั้น ระบบเซิรฟเวอรจําลองของ React จะเริ่มการทํางาน (อาจใชเวลาเล็กนอย เพราะแอปมี

ขนาดคอนขางใหญ) หลังจากนั้น เว็บเบราวเซอรที่ถูกตั้งคาเปนดีฟอลตจะถูกเปดขึ้นมาโดยอัตโนมัติ 

พรอมกบัแสดงผลทีต่ําแหน�ง http://localhost:3000 (หรือเทยีบเทากบั http://127.0.0.1:3000) โดย 

3000 หมายเลขพอรต ดังภาพถัดไป ซึ่งเปนหนา Homepage ที่ React สรางไวใหลวงหนา
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ระบบเซิรฟเวอรจําลองจะทํางานตอเนื+องไปเรื+อย ๆ  ซึ่งในระหวางนั้น หากเราเปดเบราวเซอรตัวอื+นขึ้นมา 

แลวกําหนด URL เปน http://localhost:3000 (หรือ http://127.0.0.1:3000) ก็จะไดผลในแบบเดียวกัน และ 

ถาเราตองการหยุดการรัน ใหกลับไปที่ Terminal แลวคลิกบนพื้นที่วางของมัน (เพื+อให Terminal อยูในสถานะ  

Active) แลวกด <Ctrl +C> จากนัน้เมื+อม ีPrompt  

ขึ้นมาถาม ก็ใหตอบ Y (Yes) เพื+อยืนยัน แลว

เซิรฟเวอรจําลองจะหยุดทํางาน ดังน้ัน การ

สื+อสารระหวางเบราวเซอรกับเซิรฟเวอรจะสิ้น

สุดลง และถาเราตองการกลับไปรันอีกครั้ง ก็

พิมพคําสั่ง npm start ตามเดิม แลวหยุดรัน

ดวย <Ctrl + C> เปนเชนนี้ไปตลอด

หลักการของ React JSX 
JSX (JavaScript XML) เปนเทคนิคการเขียนแท็ก HTML ภายในโคดของ JavaScript โดยไมใชวิธีการ

แบบสตรงิ ซึง่ JSX ถอืเปนจดุเดนอกีอยางหน่ึงของ React แตกอนอื+น เราลองมาดวูธิกีารเขยีน HTML ลงในโคด  

JavaScript แบบปกติทั่วไป ที่ตองกําหนดขอบเขตดวยเครื+องหมายคําพูด (Quotes หรือ Backticks) อันใด 

อันหนึ่ง ดังนี้ (ยังไมใช JSX)

const head = "<h2>React & React Native</h2>"
const text = '<div><b>Create Web & Mobile Apps with JavaScript</b></div>'
const table = `
 <table>
  <tr><th>Column 1</th><th>Column 2</th></tr>
  <tr><td>...</td><td>...</td></tr>
  ...
 </table>`
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แตการเขียนในแบบ JSX เราไมตองเขียนเครื+องหมายคําพูดกํากับ สามารถเขียนโคด HTML ลงไป

โดยตรงเหมือนกับในเว็บเพจ และถาสตริงนั้นยาวเกิน 1 บรรทัด ใหเขียนไวในวงเล็บ () เชน

const head = <h2>React & React Native</h2>
const text = <div><b>Create Web & Mobile Apps with JavaScript</b></div>
const table = (
 <table>
  <tr><th>Product</th><th>Price</th></tr>
  <tr><td>React</td><td>320</td></tr>
  <tr><td>React Native</td><td>340</td></tr>
  ...
 </table>
) 

จะเห็นไดวาการเขียนโคด HTML ในแบบ JSX นั้น ทําไดงายกวาและเปนหนึ่งของ JavaScript โดย 

ไมตองเขยีนเครื+องหมายคาํพดูกํากับใหดยูุงเหยงิ อยางไรกต็าม โคดดงักลาวไมตรงตามหลกัการของ JavaScript  

ดงันัน้ React จึงมกีลไกทีช่วยแปลงจาก JSX ไปเปนสตรงิตามรูปแบบทีถ่กูตองของ JavaScript ดงันัน้ จงึสามารถ 

นําไปแสดงผลบนเบราวเซอรไดตามปกติ โดยไมเกิดปญหาใด ๆ

และนอกจากนี้ การใช JSX ยังมีขอกําหนดและลักษณะที่เราควรรูเพิ่มเติมอีกหลายประการ ดังราย

ละเอียดตอไปนี้

 ไฟล JavaScript ที่เราจะเขียน JSX ได ตองนําเขา (import) คอมโพเนนตที่ชื+อ React จากโมดูล 

'react' เปนอันดับแรก เชน

import React from 'react'

 แท็ก HTML ที่เขียนในแบบ JSX ตองบรรจุอยูใน Parent หรือมี Container ที่มีแท็กเปดและแท็ก

ปดเพื+อกําหนดขอบเขตแทนการใชเครื+องหมายคําพูด เชน

const t1 = <div><b>Hello React</b></div> //มี div เปน Parent

//หรือสามารถใชแท็กวางเปน Parent ก็ได เชน

cost t2 = <>This text is in empty parent</>
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//แตถาเขียนแบบนี้จะเกิดขอผิดพลาด เพราะทั้งหมดไมอยูใน Parent
const t3 = <br/><span>Hi React</span> //Error เพราะเริ่มตนดวย <br/>
const เพราะไมม ีParent

 ถามีหลายบรรทัด ใหเขียนไวในวงเล็บ () เชน

const table = (
 <table>
  <tr><th>Product</th><th>Price</th></tr>
  <tr><td>React</td><td>1000</td></tr>
  ...
 </table>
)

 เนื+องจาก JSX ใชหลกัการของ XML ดงันัน้ แทก็ HTML ทัง้หมดทีเ่ขยีนตองมีทัง้แทก็เปดและปดคูกนั 

เสมอ คือเริม่ตนดวย Open Tag ในแบบ <tagname> และสิน้สดุดวย Close Tag ในแบบ </tagname>  

แตกรณีที่เปนแท็กเดี่ยว (Sigle Tag) ใหเขียนในแบบ <tagname/> เชน

แท็กปกติของ HTML แท็กในแบบ JSX

<br> <br/>

<hr> <hr/>

<input ...> <input ... />

<img ...> <img .../>

 เราสามารถเขียน HTML ในแบบ JSX ใหกับตัวแปร คาคงที่ ฟงกชัน หรือกําหนดเปนอารกิวเมนต

ของฟงกชัน และอื+น ๆ  อีกหลายแบบ เชน

import React from 'react'

let title = <h2>React & React Native</h2>

function showFooter() {
 return <div>&copy;2000-2030 developerthai.com</div>
}
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function test(html) {
 ...
}

test(<h3>Hello</h3>) //สามารถกําหนด HTML ใหเปนอารกิวเมนตเมื+อเรียกฟงกชัน

 เราสามารถแทรกคาตวัแปรหรอืคาจากฟงกชนั หรอื Expression ท่ีมผีลลพัธเกดิขึน้ ลงใน JSX ไดเชน

เดยีวกับการแทรกลงใน Template String ของ JavaScript โดยระบตุวัแปรไวในวงเลบ็ { } แตกรณนีี้ 

ไมตองเขยีนเครื+องหมาย $ ไวหนาวงเลบ็เหมอืนทีต่องทาํใน Template String ของ JavaScript เชน

import React from 'react'

let r = 'React'
let rn = 'React Native'
let title = <span>Developing Web & Mobile Apps with {r} & {rn}</span>
let a = 10
let b = 20
let x = <div>{a} + {b} = {a + b}</div>

 หากขอมูลที่นํามาแทรกเปนแบบอารเรย สมาชิกทั้งหมดจะถูกเชื+อมตอเปนสตริงเดียวกัน เชน

let a = ['red', 'green', 'blue']
let b = <div>{a}</div>  //b = redgreenblue

 หากตวัแปรท่ีเรานํามาแทรก มีแทก็ HTML รวมอยูดวย (HTML String) เมื+อแสดงผล จะปรากฏเปน

แท็กในแบบสตริงตามเดิม เชน <b>Hello</b> แตหากเราตองการใหแท็กถูกประมวล ตองกําหนด

ดวยแอตทริบิวต dangerouslySetInnerHTML ดังโคดตอไปนี้

let r = '<b>React</b>'
let a = <span>{r}</span>   //a = <b>React</b>
let b = <span dangerouslySetInnerHTML={{__html: r}}/>  //React จะเปนตัวหนา

 นอกจากการแทรกคาตัวแปรแลว เรายังสามารถกําหนดเงื+อนไขแบบ Ternary ภายในวงเล็บ { }  

ดังแนวทางตอไปนี้

let success = false
const msg = <div>{(success) ? 'Yes' : 'No'}</div>
//หมายความวา หาก success = true จะแทรกคําวา 'Yes' มิฉะนั้นจะแทรกคําวา 'No'
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let num = parseInt(Math.random()*10)
const oddEven = (
  <div>
      {num % 2 == 0) ? 'Even' : 'Odd'}
  </div>
)
//ถาหาร 2 ลงตัว จะแทรกคําวา 'Even' มิฉะนั้น จะแทรกคําวา 'Odd'

 เนื+องจาก HTML ที่เขียนในแบบ JSX ตองถูกแปลงเปนสตริงในรูปแบบโคดของ JavaScript ดังนั้น 

การเขียนแอตทริบิวตของ HTML ตองตรงตามหลักการของ JavaScript ซึ่งสามารถสรุปประเด็นที่

น�าสนใจไดดังนื้

 ๏ แอตทริบิวตที่ตรงกับ Reserved Word ของ JavaScript ไดแก class และ for ใหแทนดวย 

คาใหม ดังนี้

แอตทริบิวตแบบ HTML แอตทริบิวตแบบ JSX

class className

for (ปกติใชกับ label) htmlFor

<div className="container">...</div>
<label htmlFor="login">Login</label>
<input id="login" ... />

 ๏ แอตทรบิวิตทีเ่ปนคาํเดียว ใหเขยีนเปนตวัพมิพเลก็ทัง้หมดตามแบบเดมิของ HTML เชน id, style, 

name, value, placeholder, src, disabled เปนตน

 ๏ แอตทรบิวิตทีเ่กดิจากการนาํตัง้แต 2 คําขึน้ไปมารวมกัน ใหเขยีนแบบ camelCase นัน่คอื คาํแรก 

ใหขึ้นตนดวยตัวพิมพเล็ก แตคําที่ 2 เปนตนไปใหขึ้นตนดวยตัวพิมพใหญ เชน

แอตทริบิวตแบบ HTML แอตทริบิวตแบบ JSX

maxlength maxLength

tabindex tabIndex

onclick onClick

onmousedown onMouseDown

... ...
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const input = 
 <input type="number" id="n1" className="num" maxLength="5" />

 หากตองการเขียนคําอธิบาย (Comment) แทรกใน JSX ตองเขียนในแบบ  

{/* คําอธิบาย */} เทานั้น จะใชรูปแบบของ HTML คือ <!-- --> ไมได เชน

const table = (
 <table>
  <tr><th>Product</th><th>Price</th></tr>
  {/*
  <tr><td>React</td><td>1000</td></tr>
  */}
 </table>
)

หลักการเขียน HTML ในแบบ JSX ดังที่กลาวมานี้ เปนพื้นฐานเพียงสวนหนึ่งเทานั้น สําหรับลักษณะ

ปลีกยอยอื+น ๆ  รวมถึงแนวทางการนําไปใชงาน ขอใหดูรวมกับหัวขอตอ ๆ  ไป

ReactDOM และการแสดงเว็บเพจ
ในมุมมองของ JavaScript นั้น DOM (Document Object Model) คือออบเจ็กตสําหรับการเขาถึงและ

จัดการอิลิเมนตตาง ๆ  ภายในเพจ เชน อานคา เปลี่ยนแปลง เพิ่ม และลบอิลิเมนตในเอกสาร HTML เปนตน 

สวนใน React ก็มี DOM เชนเดียวกัน โดยอยูในรูปแบบของคอมโพเนนตที่ชื+อ ReactDOM ซึ่งหนาที่หลัก ๆ  ที่

เราจะไดใชงานในเบื้องตนก็คือ การแสดงผลเว็บเพจ โดยมีแนวทางดังตอไปนี้

 การใชงาน ReactDOM อาจทําไดใน 2 รูปแบบคือ

 ๏  แบบที่ 1 นําเขาคอมโพเนนต ReactDOM จากโมดูล 'react-dom' แลวแสดงผลโดยเรียก

เมธอด render() ผานคอมโพเนนตนี้เชน

import ReactDOM from 'react-dom'

ReactDOM.render(...) //เมื+อตองการแสดงผล

 ๏  แบบที่ 2 นําเขาเมธอด render() แบบเจาะจงจากโมดูล 'react-dom' แลวแสดงผลดวยการ

เรียกเมธอด render() โดยตรง เชน (ถาไมเขาใจ ใหยอนกลับไปดูที่หัวขอการนําเขาโมดูล)
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import {render} from 'react-dom'

render(...)   //เมื+อตองการแสดงผล

 เมธอด render() ซึ่งใชสําหรับการแสดงผลเว็บเพจ มีรูปแบบดังนี้

render(element, container [, callback])

 ๏ element คือสิ่งที่เราจะแสดงผล ซึ่งอาจกําหนดเปน HTML ในแบบ JSX โดยตรง หรือจะนําคา

มาจากตัวแปร หรือฟงกชัน หรืออื+น ๆ  อีกหลายแบบ

 ๏ container คือเปาหมายในการแสดงผล (นํา HTML มาแสดงผลในอิลิเมนตนี้)

 ๏ callback อาจระบุเมื+อเราตองการกระทําบางอยางเมื+อแสดงผล โดยเรียกฟงกชันเปาหมายขึ้น

มาทํางาน

 สําหรับแนวทางการนําไปใชก็คือ การแสดงผลแอปที่เราสรางขึ้น โดยในเบื้องตนมี 3 ไฟลหลัก ๆ  ท่ี

เกี่ยวของคือ

 ๏ public/index.html เปนตําแหน�ง container ที่จะแสดงผล

 ๏ src/App.js กําหนดองคประกอบสวนตาง ๆ  ของแอป

 ๏ src/index.js แสดงองคประกอบที่กําหนดไวใน App.js ออกไปที่ index.html

แสดงผลออกไป 

ที่เว็บเบราวเซอร
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สําหรับในเบื้องตน เราจะเขียนโคดที่ไฟล App.js เปนหลัก โดยหากตองการทดสอบ JSX ก็อาจกําหนด

โคดไวในฟงกชัน App() โดยลบโคดเดิมที่ React สรางมาใหในฟงกชันทิ้งไป โดยหลังการแกไขโคด ใหบันทึก

การเปลีย่นแปลงกอนรนัทดสอบ (Ctrl + K + S) แลวทาํการ Refresh เบราวเซอรเพื+อดผูลลพัธลาสุด ซึง่แนวทาง

การทดสอบบางสวนเปนดังนี้ (นํามาแสดงเฉพาะโคดที่เกี่ยวของในไฟล App.js)

react/app1-1/src/App.js

function App() {
 return <h3>Hello Word! <br/>สวัสดีชาวโลก</h3>
}

function App() {
 let r = 'React'
 let rn = 'React Native'
 const el = (
  <div>
   Create Web & Mobile Apps<br/>
   with {r} & {rn}
  </div>
 )
 return el
}

function App() {
 return (
  <table border="1">
   <tr><th>Product</th><th>Price</th></tr>
   <tr><td>React</td><td>320</td></tr>
   <tr><td>React Native</td><td>340</td></tr>
  </table>
 )
}

การกําหนดสไตล CSS รวมกับ JSX
กรณทีีเ่ราตองการปรบัแตงเวบ็เพจดวย CSS หากเขียนโคดในแบบ JSX กม็หีลกัการบางสวนทีแ่ตกตาง

ไปจากกรณีที่เรากําหนด CSS ใหกับเอกสาร HTML โดยตรง ซึ่งการนํา CSS มาใชรวมกับ JSX จะแบงเปน  

2 ลักษณะคือ แบบ Inline Style และ External Style ดังรายละเอียดตอไปนี้
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การกําหนดสไตลแบบ Inline
การกําหนดสไตลแบบ Inline ก็คือการเขียนโคด CSS ไวที่แท็ก HTML โดยตรง ซึ่งในกรณีที่เราเขียน

โคดในแบบ JSX ก็มีหลักการที่แตกตางจากแบบปกติดังนี้

 กําหนดสไตลในแบบออบเจ็กตของ JavaScript โดยชื+อพร็อปเพอรตี้ตองเขียนในแบบ camelCase 

หามมีขีดคั่นระหวางคําตามหลักการของ JavaScript และคาของพร็อปเพอรตี้ตองกําหนดไวใน

เครื+องหมายคําพูด

 นําออบเจ็กตของสไตลมากําหนดใหกับแท็กดวยแอตทริบิวต style ตามปกติ แตตองเขียนคาของมัน

ไวในวงเล็บ { } เชน

const divStyle = {      //สรางสไตลในแบบออบเจ็กต

 color: 'red',
 backgroundColor: 'powderblue',  //แบบ CSS คือ background-color
 fontSize: 'larger',    //แบบ CSS คือ font-size
}

return <div style={divStyle}>Hello React</div>

 เราสามารถกําหนดไสตลยอย ๆ  ใหแกแท็กเดียวกันในแบบของอารเรย เชน

const redText = { color: 'red' }
const darkBg = { backgroundColor: 'black' }
...
return <div style={[redText, darkBg]}>Hello React</div>

 หรืออีกวิธีคือ กําหนดไสตลในแบบออบเจ็กตใหกับแท็กโดยตรง ดังโคดถัดไป (วงเล็บ { } อันขางใน

ใชกําหนดออบเจ็กต สวนอันขางนอกใชสําหรับกําหนดสไตลในแบบ JSX)

<div style={{color:'red', backgroundColor:'powderblue'}}>
 Hello React
</div>
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แนวทางการเขียนโคดโดยรวมที่ไฟล App.js จะมีลักษณะดังนี้

react/app1-1/src/App.js

function App() {
 const divStyle = {
  color: 'red',
  backgroundColor: 'powderblue',  
  fontSize: 'larger',
  padding: '3px',
 }
 return <div style={divStyle}>Hello React</div>
}

การกําหนดสไตลแบบ External
การกําหนดสไตลแบบ External เปนการแยกสวนของ CSS ไปสรางเปนไฟลไวตางหาก และในกรณี

ของ React จะนําสไตลเขามาใชงานในเพจหรือไฟลที่ตองการ โดยใชคําสั่ง import ในแบบเดียวกับโมดูล ซึ่ง

หลักการที่สําคัญมีดังนี้

 สรางไฟลใหมเพิม่เขามาในแอป โดยใหมสีวนขยายเปน .css แลวภายในไฟลดงักลาว จะตองมเีฉพาะ

โคด CSS เทานั้น หามมีแท็ก <style> รวมอยูดวย

 ไฟลหรอืเพจทีจ่ะนาํสไตลไปใชงาน ใหนาํเขาดวยคาํสัง่ import './ชื+อไฟล CSS' เชน สมมตวิาตองการ

นําเขาไฟลที่ชื+อ global.css ก็กําหนดโคดเปน import './global.css'

 สไตลที่นําเขามาจะมีผลกับแท็ก HTML ที่ตรงกับ Selector ซึ่งระบุไวในไฟล CSS แมจะเขียนใน

แบบ JSX ก็ตาม 

react/app1-1/src/style.css

h2 {
 font-size: 20px;
 color: blue;
}

.title {
 font-size: 16px;
 color: green;
 text-decoration: underline;
}
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react/app1-1/src/App.js

import React from 'react'
import './style.css'

function App() {
 return (
  <>
   <h2>DeveloperThai.com</h2>
   <div className="title">React & React Native</div>
  </>
 )
}
export default App

การใชเมธอด Array.map() รวมกับ JSX
หากเราตองการเขาถงึเพื+อดาํเนนิการกับสมาชกิทัง้หมดในอารเรย ซึง่ตามปกติกม็ลีปู for แบบตาง ๆ  รวม

ถึงเมธอด forEach() ของอารเรยใหใชงานอยูแลว แตเนื+องจากลูป for รวมถึงเมธอด forEach() ไมคืนคากลับ

มา จึงไมสะดวกตอการใชงานรวมกับ React JSX อยางไรก็ตาม อารเรยใน JavaScript ยังมีเมธอด map() ที่

ทํางานคลายกับ forEach() ดังรูปแบบตอไปนี้

map(function(item) { หรือ map(function(item, index) { ...})
 ...
 return ...
})

หรืออาจเขียนในแบบ Arrow Function เปน

map((item) => {  หรือ map(item => { ... })  หรือ map((item, index) => { ... })
 ...
 return ...
})

 item คือคาของสมาชิกในการวนลูปแตละรอบ

 index อาจระบุเมื+อเราตองการอางถึงลําดับของสมาชิก

 ภายในบล็อกของ map() ตองมีคําสั่ง return เพื+อสงคาในแตละรอบกลับออกไป ยกเวนกรณีที่ใช 

Arrow Function หากมีเพียงคําสั่งเดียว อาจไมระบุ return ก็ได
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จะเห็นไดวา map() จะคลายกับ forEach() แตขอแตกตางที่สําคัญคือ เมธอด map() จะคืนคาผลลัพธ

ในแตละรอบของการวนลูปกลับคืนมา โดยลักษณะปกติของ map() ใน JavaScript นั้น จะคืนคากลับมาเปน

อารเรยของผลลัพธที่ได ดังโคดตอไปนี้

let colors = ['red', 'green', 'blue', 'yellow']
let list = colors.map(c => `<li>${c}</li>`)
//list = ['<li>red</li>', '<li>green</li>', ...]

แตเมื+อนํามาใชกับ JSX อารเรยจะถูกแปลงเปนสตริงเดียวกันหรือนําสมาชิกแตละตัวมาเชื+อมตอกัน

นั่นเอง ตามหลักการของ JSX ที่ไดกลาวไวแลว ซึ่งถือวาเปนประโยชนอยางมาก เพราะเราไมตองเสียเวลาอาน

คาสมาชิกมาเชื+อมตอกันทีละตัว ดังแนวทางในโคดตอไปนี้

react/app1-1/src/App.js

import React from 'react'
function App() {
 let colors = ['red', 'green', 'blue', 'yellow']
 let list = colors.map(c => <li>{c}</li>) //แทรกคาแบบ JSX
 //list = <li>red</li><li>green</li>...
 return <ul>{list}</ul>

     //หรือเรียกเมธอด map() ใน JSX โดยตรง

 /*
 return (
  <ul>
   {colors.map(c => <li>{c}</li>)}
  </ul> 
 )
 */
}

ในบทตอ ๆ  ไปเรา เราจะไดใชงานเมธอด map() อยูบอย ๆ  ซึง่ในบทน้ี เพยีงแคแนะนําหลกัการในเบือ้งตน 

ใหทราบลวงหนาเอาไวกอนเทานั้น

การแสดงรูปภาพใน React App
รปูภาพ คือองคประกอบทีส่าํคัญอยางหนึง่ซึง่เราจาํเปนตองนาํมาแสดงผลในเวบ็เพจอยูบอย ๆ  และสาํหรับ

ใน React นั้น ก็มีวิธีการจัดเก็บและอางถึงตําแหน�งรูปภาพภายในแอป ดังนี้
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 ตามหลักการแลว เราควรจัดเก็บรูปภาพในโฟลเดอร public หรืออาจสรางโฟลเดอรยอย ๆ  ซอนไว 

ใน public เพื+อแยกเก็บรูปภาพใหเปนสัดสวนจากไฟลอื+น ๆ  ก็ได เชน public/images เปนตน

 กรณีที่เราจัดเก็บภาพไวในโฟลเดอร public หากตองการอางถึงภาพในโคด JSX ก็อาจเลือกใชวิธีใด

วิธีหนึ่งดังนี้ (สมมติวาตองแสดงภาพที่ชื+อ logo192.png ซึ่งอยูใน public)

react/app1-1/src/App.js

function App() {
 //เลือกใชแบบใดแบบหนึ่ง

 //return <img src="./logo192.png" alt=""/>
 //return <img src={"./logo192.png"} alt=""/>
 //return <img src={(process.env.PUBLIC_URL + "/logo192.png")} alt=""/>

 //ถาจัดเก็บภาพในโฟลเดอรยอย ๆ  ซอนอยูใน public ก็ใหระบุโฟลเดอรนั้นดวย เชน

 //ถาเก็บภาพไวใน public/images ก็อางอิงตําแหน�งเปน

 //return <img src="./images/logo192.png" alt=""/>
}

 หรือถาเราจัดเก็บภาพในโฟลเดอร src การอางถึงตําแหน�งภาพในโคด JSX ก็ทําดังนี้ (สมมติวา

ตองการแสดงภาพที่ชื+อ logo.svg ซึ่งอยูในโฟลเดอร src)

react/app1-1/src/App.js

import logo from './logo.svg'  //ภาพอยูที ่src/logo.svg

function App() {
 return <img src={logo} width="10%" alt=""/>
}

สิ่งที่เราไดศึกษาในบทนี้ ท้ังวิธีการเขียนโคด HTML และ CSS ในรูปแบบ JSX รวมถึงลักษณะปลีกยอย

อื+น ๆ  จะเปนพื้นฐานสําคัญสําหรับใชในการพัฒนา Web Application ดวย React ที่จะกลาวถึงในบทตอ ๆ  ไป
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